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BELINDA GIBSON
Coming from a sewing family, Belinda worked as a manager for the local
BERNINA® store for over 19 years. Belinda loves all kinds of sewing but
especially likes sewing Art to Wear, garment embellishment & appliqué,
garment construction and Home Dec. 

NINA MCVEIGH
During 14 years of owning her own store, Nina developed and taught
her original patterns and designs in BERNINA® Clubs and Classes. An
avid quilter, heirloom sewer and lover of all kinds of embellishment,
she is also a collector of scissors, buttons and thread!  

JENNIFER GIGAS
Jennifer’s first loves are heirloom sewing and embellishment techniques.
She’s passionate about anything related to sewing and delighted to be
able to share the knowledge she’s accumulated. Jennifer was a freelance
teacher and trainer for BERNINA® of America, Inc. before becoming a

full-time Education Consultant. 

BARBARA ALENCI
Barbara has been involved with sewing since she was 11 years old and
started making her own clothes. She opened a quilt shop in Florida 12
years ago, and a year later became a BERNINA® dealer. Since closing
her shop, she has been working for BERNINA®. Her favorite part of the
job is teaching, and seeing the enthusiasm on the faces of her students.

JESSIE BENNION
Seventeen years old and a senior in a small high school in Cokeville,
Wyoming, Jesse Bennion learned to sew from her mother who is also her
4-H leader. See how that led her to winning a brand new BERNINA®

serger this year in the Make It Yourself With Wool contest.

PATRICIA BOLTEN
Patricia Chatham Bolton is co-founder and editor-in-chief of QUILTING ARTS MAG-
AZINE and CLOTH PAPER SCISSORS. She was introduced to embellished quilting
and the related needle arts six years ago, and ever since she took her first stitch (a
fly) and embroidered her first motif (a spider), she has been entangled in this
hobby and doesn't envision herself free. You can find out more about her and her
publications by visiting the Quilting Arts Web site at www.quiltingartsllc.com. 

NANCY BEDNAR
Nancy is a BERNINA® Educator and is co-author of The Encyclopedia of
Sewing Machine Techniques. Her new book, Creative Serging: A
Comprehensive Guide, was released Spring of 2005.

CINDY MICHAELS
Before becoming a BERNINA® Educator, Cindy worked for 12 years for a
BERNINA® store in Southern California as a teacher and sales person,
both in-store and at fairs, home shows, and quilt and craft seminars.

JILL DANKLEFSEN
Jill’s exquisite work with manipulating decorative stitches – playing with
them, changing them. creating texture with them – is one of her special-
ties as a BERNINA® Educator.
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Libby Lehman was recently announced as the winner of the 2004 BERNINA®

Quilt Leadership Award. Given in recognition of the contribution Libby has
made to the national quilting industry throughout her career, this annual
award has also been bestowed on Karey Bresenhan (2002), Caryl Bryer
Fallert (2003), and Georgia Bonesteel (2004). 

As a distinguished quilter and lecturer, Libby shares her unique style with
thousands of students each year, inspiring them to experiment with quilting
techniques and decorative threads. She began sewing traditional quilts nearly
30 years ago, but it was years before Libby began to truly explore her own
creativity, to follow her inspirations. Today, Lehman's quilts are far from tradition-
al. Her "studio art quilts" capture her unique style of freemotion quilting and her
vivid imagination. Always innovative, Libby Lehman proves that quiltmaking is
an art form. It's no wonder that one of her quilts was selected as one of the
hundred best of the 20th Century. Her words, her stories, her quilts, are an
inspiration to quilters everywhere. 

According to Libby, anyone can be creative; they just may not realize it. She
says, “You have to foster your creativity. It's not something that just shows up at
will. I think you have to pay attention to it. You have to exercise it. Play is a big
part of creativity. So many people want to be perfect the first time they attempt
something, and you need to play. You need to give yourself permission to get
over that learning curve. I tell people, think of how long it took you to learn to
write your name. You didn't do that overnight. Play around with making a quilt,
and don't expect perfection right off." It’s no wonder that the title of her book
and the style of her technique is Threadplay.

Libby began using BERNINA® machine about 12-15 years ago and she says,
"BERNINA® changed my life, literally. I was making traditional quilts at the time,
and the machine I was using was just not satisfactory for the kind of machine
embroidery and machine quilting I wanted to do. I went to a conference that
Nancy Crow put on, and BERNINA® furnished the machines for us to use. It
was eye-opening -- it just made everything so much easier. It was like sewing
through butter. Whereas my other machine I had to fight it the whole way." 

Libby received a beautiful Swiss music box, presented to her by Martin Favre,
President of BERNINA® of America, Inc. The ceremony took place at BERNINA®

University, an annual training seminar conducted for BERNINA® dealers across
the country. Libby graciously accepted the award, saying, “What an honor! I
was floored as it was totally unexpected. But then, BERNINA® always does
the unexpected. I truly would not be where I am if BERNINA® was not
where it is. One of their newest innovations is terrific. I'm talking about the
BERNINA® STITCH REGULATOR, of course. While I've spent a long time
perfecting my freemotion quilting, the BSR is a welcome addition to my
repertoire. I'll take all the help I can get!”

Find out more about Libby and her quilts on the BERNINA® USA web site in
BERNINA® Portraits or visit Libby's site at http://www.libbylehman.us/index.html.

Libby received a beautiful Swiss music box,
adorned with inlaid wood patterns.

Martin Favre, President of BERNINA® of
America, Inc. presents the Quilt Leadership
Award to Libby Lehman at BERNINA®

University 2005 in Chicago, IL during a
Roaring ‘20s themed party.



A SEWING SYMPHONY
How many of you listen to music while you sew? I have a hunch most of us do—it
helps with relaxation and aids in the flow of our working process. Do you prefer
soft, soothing refrains? Or loud tunes with a beat you can dance to? Do you speed
up when cutting fabric or step on that foot pedal a little harder when you hear a
snappy rhythm?

Just as music stirs the soul, the sight of inspirational and intriguing stitching
awakens the creative heart of today’s stitchers. And just as we all have our

favorite kinds of music, whether classical, country, or alternative, we also have our favorite types of
sewing. And just as there is a musical genre for each of us, there are also sewing segments suited
to each of us – home dec, heirloom, embellishment, craft, garment-making, and/or quilting.

A conductor skillfully manages a variety of instruments to achieve the most beautiful harmony;
today’s stitchers combine a variety of tools – a sewing machine (or two or three!), serger,
embroidery system, software – with quality fabric and notions to achieve the most pleasing results.

Whether your style is adagio or allegro, whether you work on your projects a cappella or with other
sewers in a “symphony” of sewing, there are lots of wonderful comparisons between beautiful music
and beautiful stitchery.

BERNINA® Educators will be in selected dealers’ stores this fall performing their own melodies in a
consumer program entitled “Sewing Symphony”. Look for the program at the stores listed on the
following page and on the berninausa.com web site. We hope to see you in our “concert halls” so
we can show you our newest compositions, guaranteed to inspire and delight.

This issue of Through The Needle details many of the projects and techniques that are featured in
the “Sewing Symphony” program. One of the highlights of the program is the aurora 440QEE with
the innovative BERNINA® Stitch Regulator feature. From quilting to thread painting, this unique
feature makes all freemotion techniques possible for any stitcher – beginner to advanced. The
Wheel of Mystery Quilt on page 6, the Porcelain Jacket on page 28, and the Mosaic Vest on page
32 are just a few of the projects you can make using the BSR.

If you’re into crafting, the Needlepunch pillow on page 19 may be just the home accent your looking
for. And join in on the latest craze, Artist Trading Cards. Read about these fun cards on page 24

and start planning your own so you can stitch and swap with all your
friends.

Check the listing on the
following page to see if
there’s a BERNINA®

dealer near you hosting
the program. Come see
us and you can see
firsthand how you and
BERNINA® can make
beautiful music together.

from BERNINA®

GAYLE HILLERT
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ALABAMA

Robin's Sewing Shoppe, Hoover

ARIZONA

The BERNINA® Connection, Phoenix
Sew from the Heart, Scottsdale
Sun Valley Quilts, Sun City
BERNINA® Southwest, Mesa

ARKANSAS

The French Seam, Stuttgart

CALIFORNIA

Baron’s Fabrics, Camarillo
Bolts in the Bathtub, Lancaster
Sew Vac Ltd, Long Beach
Redlands Sewing Center, Redlands
California Sewing & Vacuum, San Jose

COLORADO

The Presser Foot, Longmont

DELAWARE

Hayes Sewing Machine Co, Wilmington

FLORIDA

Quilting Folks, Cocoa
Paula's Fine Fabrics, Jacksonville
Quilter's Choice, Jupiter
BERNINA® Sewing Centre, Orange City
Calico Station, Orange Park
Derrel's Sewing Ctr, Panama City
Derrel's of Pensacola, Pensacola

GEORGIA

Sewing Gallery, Augusta

HAWAII

BERNINA® of Hawaii, Honolulu

IDAHO

The Quilt Crossing, Boise
Bear Paw Quilting, Couer d Alene
Becky's Fabrics & BERNINA®, Lewiston

ILLINOIS

Linda Z's, Arlington Hts
Cross Patches, Collinsville
Stitches & Stuffing, Naperville

INDIANA

Quilt Quarters, Carmel

KANSAS

Hutchinson Midwest S/C, Hutchinson
BERNINA® Sewing Ctr, Overland Park
Fabric Corner, Topeka

MARYLAND

Lilies in the Field, Easton
Fabric Chest, Glen Burnie
Material Girls Quilt Boutique, LaPlata
G Street Fabrics, Rockville

MASSACHUSETTS

Ann's Fabrics, Canton
The Fabric Studio, Swansea

MICHIGAN

Gall Sewing & Vac, Grand Rapids

MINNESOTA

Quilter’s Courtyard, Minneapolis 
Bear Patch Quilting, White Bear Lake
Crafty Corner Quilt Shop, Worthington

MISSOURI

Eunice Farmer Fabrics, St Louis

MONTANA

BERNINA® Sewing Center, Billings
Beverly's BERNINA®, Bozeman
BERNINA® Silver Thimble, Great Falls
Sues Sewing Palace, Helena

NEBRASKA 

BERNINA® Sewing Studio, Lincoln
BERNINA® Sewing Center, Omaha

NEW JERSEY

BERNINA® Sewing Ctr, Matawan 

NEW MEXICO

BERNINA® Sewing Ctr of Four Corners,
Farmington

NEW YORK

Aurora Sewing Center, E Aurora

NEVADA

BERNINA® of Las Vegas, Las Vegas 

NORTH CAROLINA

Asheville Cotton Co, Asheville
Loving Stitches, Fayetteville

Sew Much Fun, Gastonia
BERNINA® is Sew Much Fun, 
Wilmington

OHIO

BERNINA® Main Street, Dayton

OKLAHOMA

BERNINA® of OKC North, OKC
Sue's Sewing Shoppe, Shawnee

OREGON

Eugene Vac & Sewing,Eugene
Stretch & Sew Fabrics, Keizer
Rich's Sewing & Vacuum, Salem

PENNSYLVANIA

Sew Elegant, Clarion 
Hinkletown Sewing, Ephrata 
Danner's BERNINA® Shoppe, Hanover
Steve's Sewing, King of Prussia
Hoover's BERNINA® Sewing Center,
Mifflinburg
Byrne Sewing, New Britain

RHODE ISLAND

Blaine Sewing Mach Ctr, Cranston

SOUTH CAROLINA

BERNINA® Sewing Ctr, Greenville

TEXAS

Let's Sew BERNINA®, Desoto
It's a Stitch, Humble
BERNINA® Sewing Studio, Lubbock
Creative Sewing Ctr, San Antonio
Sew Special Quilts, San Antonio
Nimble Thimble, Tyler

UTAH

Dave's BERNINA®, Provo

VIRGINIA

Sew Biz, Radford

WASHINGOTN

E-Z Knit Fabrics, Spokane
The Quilting Bee, Spokane

WISCONSIN

Bigsby's Sewing Center, Brookfield
Fond Du Lac Quilting, Fond Du Lac
Life's a Stitch, De Pere
Pamellas Place, Genesee Depot

Call your dealer for program dates, times, and details.
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All the pieces needed for the center of this fabulous
Triple-Dyed Bali Batiks quilt are pre-cut and come
in a kit designed by renown quilter, John Flynn,

and produced by Benartex fabrics.

Center of Quilt
Follow the directions that are included with the John
Flynn kit to piece the center of the quilt. Use the
Patchwork Foot with Guide #57, keeping the raw edges
of the fabric next to the guide for perfect 1/4” seams.

Tips for piecing curved seams: 
• Make a clip at the center of the two curved edges to

create a registration mark or notch for matching. 

• Sew with the outer curve on top of the inner curve,
using a stiletto to help guide the fabric.  

• Sew at a slow even speed, matching notches as you
sew. 

• Press the seams toward the outer curve.

Borders
Cut borders and binding along the length of the fabric.
Cut 3 strips, 21/4” wide for the binding, set aside.  

For inner  border cut 2 strips, 2” wide. From these strips
cut two lengths 45” and two lengths 55”. Attach borders,
mitering the corners as shown in the diagram

Cut outer borders 51/2“ wide. Attach them in the same
manner as the inner borders, mitering the corners.

Tip: Stitch the inner and outer borders together and
attach to the quilt at the same time, treating the borders
as one in the mitering process.

Finishing the Quilt
Use the BERNINA® Stitch Regulator (BSR) or Freehand
Quilting Foot #29/29C to freemotion quilt as desired.
Bind the edges using Walking Foot #50 and your favorite
method of binding.

Make a 

spectacular 

curved pieced 

wall hanging 

without cutting 

a single 

template!

BY NINA McVEIGH
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John Flynn stumbled into quilt-making quite accidentally.
Nearly thirty years ago, when his wife Brook had taken up
quilting as a hobby, John, a civil engineer at the time, began
his attempts at building her the perfect quilt frame. It was while
field-testing his inventions that he discovered how relaxing and
artistic quilt making really was. In 1989, John Flynn closed the
doors of his bridge building company and opened the Flynn
Quilt Frame Company. Today, John Flynn is one of the foremost
quilters of our time. And although he gave up his career in civil
engineering many years ago, each and every one of his quilts
displays/exhibits the same accuracy and exacting attention to
detail that he put into building bridges. 

When asked what inspires him, John says, "I've lived in
Montana all my life, so I have quite an influence from Plains
Indian art. The inspiration for the Feathered Sun Quilt (above)
came from the Sioux Indians star quilt giveaways. This is a
long held tradition of giving gifts that would have meaning in

the life of the person they're giving it to. Before the
tribes were all displaced onto reservations, there were
plentiful buffalo on the ranges around Montana and
these designs were painted on buffalo hides. But now
these gifts are in the form of star quilts.”

John says, “BERNINA® machines are just great for quilt-
ing. First off, you don't have to worry about thread tension.

It always remains constant throughout the project and I like
that smoothness. Plus, there's plenty of power. The machine

runs smoothly at an even speed, so you're not fighting with it.
My favorite feature is the knee-activated presser foot lifter.
Because it lets both hands be free to hold the quilt.

"I've built a 3-rail style quilt frame to use when I quilt. There are
three layers to the quilt: you have the back, the filling, and the
top layer. And those have to be held stationery in relationship
to each other while you stitch the quilt. My quilt frame is the
best device to hold the quilt together while it moves under the
needle. It gives the quilter complete control."

Supplies

• Benartex “Wheel of Mystery Quilt” Kit 
by John Flynn

• Patchwork Foot with Guide #57

• #70 Jeans Needle

• Straight Stitch Throat Plate

• Cotton thread for piecing

• Oliver Twist “Over The Top” thread for quilting

• #90 Quilting Needle

• 31/8 yards of fabric for inner border, backing 
and binding

• 11/4 yards of fabric for outer border (for pieced 
borders) or 2 yards for continuous border

• Batting (56” x 66”)

• Nifty Notions “Cut For The Cure” Ruler (7” x 24”)

• BERNINA® Stitch Regulator (BSR) or Freehand 
Quilting Foot #29/29C

• Walking Foot #50 for binding

I S S U E  1 5

Flynn Quilt Frame Company
1000 Shiloh Overpass Rd, Billings, Montana 59106

Order Toll-Free at: 1-800-745-3596

Or visit the FQFC web site at: http://www.flynnquilt.com

For more information about the Quilt Frames and
Quilts designed by John Flynn, contact:

Finished size: 53” X 63”
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BY BELINDA GIBSON

CUTTING AND PREPARATION

Striped Minkee Mates Fabric
Pockets: Cut two 71/2” x 9” rectangles. Fuse interfacing to the wrong side of the fabric.
Flaps: Cut two 7” x 31/2” rectangles. Fuse interfacing to the wrong side of one flap.
Round the lower corners. 

Checked Minkee Mates Fabric
Cut approximately five 11/8” wide bias strips. Piece to make 1 strip, about 5 yds long.

Minkee Blankee Fabric 
Cut fabric 36” x 36”. 

POCKET INSTRUCTIONS

Pocket Flap 
Using Piping Foot #38, stitch the hook side of the tape to
the interfaced flap. Place pocket flaps wrong sides together;
pin. Serge around all edges. Using bias strip and the bind-
ing settings and directions on page 10, bind the curved
edge of the flap.

Pocket
Place pocket pieces right sides together. Serge all sides, leaving an opening in the cen-
ter of the lower edge; turn to the right side and press. Stitch loop tape to top of pocket
about 1” from the upper edge to correspond with the hook tape on the flap.

Sew elastic to the upper edge of the pocket using the elastic settings and
directions on page 10.

To stitch the pocket and flap to the Minkee Blankee Fabric, use the pocket
settings and directions on page 10.

EMBROIDERY INSTRUCTIONS

Note: These instructions are for the Minkee Pals outlines
on the blanket, not for the individual Pals.

Open the BERNINA® Designer Plus Embroidery
Software V4.

Right-click on the Hoop icon; in the Options
box select: artista 400 x 150 MEGA w/Grid

– Auto Split Machine. 

Select one of the designs from the
Minkee Pals Embroidery Take-Out
Collection #11936. (I chose the Teddy #CK431.)

Change the last stitching on the Minkee Pal (the single
stitch used to sew the animals together to make the

This simple quilt made of 

Minkee Blankee is the softest 

of all and has a pocket to hold 

little pets made completely 

on the embroidery machine.
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stuffed animal) to a satin stitch:
- Click on the Object Select tool; click on the outline stitch to

select it.
- Select the Outline menu at the bottom of the screen; select

Satin stitch.
- Select the Textured Edge tool (available only in the Designer

Plus software). Right-click on the object to open the Object
Properties box; change the width of the satin stitch as
desired.

- Select Satin Special. Click on Effects.
- Select Tab > Textured Edge; select the third alignment box.
- Adjust the Texture and Span tools until you create the look

you want for your “fuzzy” animal.

“Baby Bear”:
- With the Minkee Pal selected, go to Edit >Duplicate. Scale

down using the sizing handles or by left-clicking on the
Scale Up/Down 20% tool. 

- With the Minkee Pal still selected, move it above the
original Minkee Pal.

“Big Bear”:
- For the third Minkee Pal, follow the same steps as above

except scale the bear up using the sizing handles or by
right-clicking on the Scale Up/Down 20% tool.

- Move it below the original bear, at the bottom of the Mega
Hoop.

Send the design to the embroidery module/machine. If using the
artista 200E, it will automatically split the design into three
parts for the Mega Hoop.

Note: To get a more realistic view of your design, you can
change the desktop to the color of fabric the animal will be
stitched on. Go to Settings/Fabric Display/Color/Edit; change the
color of your threads by going to Settings/Thread Colors. 

Hoop the Minkee Blankee fabric:
- Cut a piece of Ultra Clean & Tear stabilizer larger that the hoop.
- Spray stabilizer with the HR5 Spray & Stick.

- Cut a piece of Aqua Film to cover the textured Minkee
Blankee fabric.

- Hoop the Minkee Blankee where the feet of the largest

animal will be, right above the pocket flap. Use the hoop
template to help you with this.

Stitch the design (all three Minkee Pal), rehooping as needed (if
not using the Mega Hoop). Remove from the hoop and carefully
tear away the stabilizers.

PIECING INSTRUCTIONS

Cuddle Quilt Back/Striped
Fabric:

- Using Nifty Notions “Cut
for the Cure” 7” x 7” square
ruler for accuracy, cut thirty-
six 61/2” x 61/2” squares.

- Wind a bobbin with
100% cotton thread.

- Put a new #75/11Quilting
needle in machine.

- Thread the machine with cotton thread. 
- Attach Patchwork Foot #57 to the machine.
- Piece the squares together, six across and six down, alternating

the direction of every other  block to create a Rail Fence effect.

QUILTING INSTRUCTIONS

Pin embroidered top and pieced back wrong sides together.
Tip: I like to use HR5 to bond the quilt together. 

Lay the blanket on a flat surface. Mark where the embroidery
and pocket are; do not quilt through those areas.

Quilt the layers together using the following quilting settings and
directions on page 10.

After quilting the layers together, round the corners of the quilt
using a plate or circular ruler as a template.

Serge the layers together along all four sides with a narrow bal-
anced 3-thread stitch. Note: This step is necessary to flatten the
edge and be successful at binding the quilt.

Bind the edges of the quilt, using the same settings as for bind-
ing the pocket flap. Start in the center of one side and leave a
tail at the end. After removing the binder, fold the end under
and stitch in place, still using Foot #94 and the same settings.

• 11/4 yard Minkee Blankee “Dot” fabric
by Benartex

• 2 yards Minkee Mates “Deck Chair
Stripe” fabric by Benartex

• 3/4 yard Minkee Mates “Mini Gingham”
fabric by Benartex

• 2” of hook-and-loop tape 

• 7” of 1/8” wide elastic 

• OESD Poly Mesh cut-away stabilizer 

• OESD Ultra Clean & Tear stabilizer 

• OESD Aqua Film water-soluble stabilizer

• HR5 Spray & Stick adhesive

• Lightweight bobbin thread 

• Embroidery needles 75/11 

• Quilting needles 75/11 

• Mettler Silk-Finish Cotton thread for
piecing and decorative stitching

• Pellon fusible, lightweight, sheer
interfacing (for pocket and pocket flap) 

• Fabric marking pen

• Mega Hoop (optional – the bears can be
stitched separately in smaller hoops by
re-hooping)

• Plexiglas embroidery table (optional but
recommended - adds support for Mega
Hoop)

• BERNINA® Designer Plus Embroidery
Software V4 

• OESD Minkee Pals embroidery collection
(Teddy is also available as a single
design, CK431)

• Presser Feet:
- Reverse Pattern Foot #1/1C or 

Clear Foot #34/34C
- Piping Foot #38 
- Walking Foot #50
- Patchwork Foot with Guide #57

- Bias Binder Attachment #84 and

Binder Foot #94

SUPPLIES

I S S U E  1 5
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BINDING SETTINGS & DIRECTIONS
Stitch: straight stitch
Width: default setting – 0 mm
Length: default setting – 2.5 mm

Needle position: half left or as desired 
Presser foot: Bias Binder Attachment and Foot
#94.

- Place Bias Binder Attachment #84 and
Foot #94 on the machine. 

- Stitch binding to curved edge of the flap,
leaving extra binding  at both ends.

- Turn ends of binding under, pin.
- Set aside.

ELASTIC SETTINGS & DIRECTIONS
Stitch: universal stitch
Width: 4mm
Length: 2.2mm (stitch should be wide

enough to sew over the elastic, but not into it)
Presser Foot: Reverse Pattern #1/1C – another
option is Clear Foot #34C/34, for more
visibility.

- Place the pocket wrong side up and posi-
tion the upper edge along the inside of the
right toe of the presser foot.

- Align the elastic with the center line on
the presser foot. 

- Stitch, stretching elastic while you sew and
securing it at the beginning and ending. 

POCKET SETTINGS & DIRECTIONS
Stitch: lycra stitch
Width: 4.3 mm
Length: 1.5 mm

Presser Foot: Walking Foot #50 with the open
sole.

- Align the center mark on the Walking Foot
with the edge of the pocket.

- Place the pocket 3” up and 3” in from the
lower right corner of the blanket; pin in
place.

- Find the center points of the pocket and
flap. Pin flap above pocket, matching
center points; stitch in place.

QUILTING SETTINGS & DIRECTIONS
Stitch: running stitch
Width: 5.5 mm
Length: 1.1-1.5 mm 

Presser Foot: Walking Foot #50 with the open
sole

- Align the center mark on the Walking Foot
with the seam line. 

- Sew along the seam lines of the quilt,
making a grid and securing stitching at the
marked stop/start points, skipping the
embroidery and pocket areas. 

TO MAKE INDIVIDUAL 
MINKEE PALS:
1. go to embroideryonline.com
2. Select PROJECTS.
3. Under Project Type select >

Craft.
4. Under collection/Card select >

Minkee Pals.
5. Click on Search > Minkee Pals 

- For Download only (OESD
pack #11936)

- Minkee Pals > Download
Instructions.

- Click on Download
Instructions. 

6. Stitch and stuff the Minkee Pals
according to the directions
given with the downloaded
designs. Alternative finishing
method: When stitching the
last color (sewing the Minkee
Pal together), stop and advance
the stitching to leave an open-
ing for turning. After turning,
stuff the Minkee Pals and
hand-stitch the seam opening
closed.







CUTTING AND PREPARATION
Trace bag front and back on fashion fabric. Transfer
all pattern markings to fabric.

From fashion fabric cut: one gusset, two 11/4” x 22”
bias strips, and one 21/2” x 91/2” welt lining strip 

From lining fabric cut three bag fronts, one bag back,
and one gusset.

Clean finish all edges of welt lining strip (serge or
use a machine overlock stitch; 1/4” allowed for serger
trimming) 

Fuse Armo® Weft to fashion fabric gusset.

EMBROIDERY
Insert new Organ Embroidery needle; thread machine
with Yenmet Metallic thread in needle, Bottom Line
thread in bobbin. Select  embroidery designs to
embellish bag; place design templates on purse pat-
tern to audition placement. Tip: Scan the bag pattern
into the BERNINA® Embroidery Software  (Auto-
Designer or Designer Plus level), then position embroi-
dery designs on the graphic to plan placement and
rescale designs as needed.

Using HR5, adhere black Heavyweight Cut-Away
stabilizer to wrong side of bag back fabric. Hoop in Large

Oval hoop, using design templates to aid in     position-
ing.

Embroider the design. Remove fabric from hoop. Cut out
bag back, leaving excess stabilizer to provide firmness to the

body of the bag.

Repeat for the front of the bag.

Baste a front lining piece to the bag front, wrong sides together.

PIPING
Insert a new Microtex Sharp needle and attach Pintuck Foot #31
to machine. Thread needle and bobbin with construction thread.

Select stitch #1 (straight stitch), move needle one position to the
right.

Place piping filler cord on the wrong
side of a bias strip. Fold strip in half,
encasing the filler cord. Position
wrapped cord under the foot in the first
groove to the left of center; stitch.

Stitch piping along bag front and backs,
stopping at marks indicated on pattern.
To end piping, curve ends into the
seam allowance.

BY JENNIFER GIGAS
Note: Read through all instructions 

completely before beginning project.
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TUXEDO ZIPPER APPLICATION
Attach Reverse Pattern Foot #1 to machine. Select straight stitch (stitch #1),
center needle position, construction thread in bobbin and needle.

Mark stitching line on
welt lining strip.
Position strip on bag
front, right sides
together.

Carefully stitch around
marked line. Cut through
the center of the welt
strip and clip into the
stitched corners as
shown above.

Turn welt strip to the inside,
pressing the edges carefully.

Use Wonder Tape to “baste” the lin-
ing strip to the back of the bag
front. Place a strip of Wonder Tape
on the outer edge of the Tuxedo zipper tape (right side of the zipper).
Center the welt window over the zipper, using the Wonder Tape to hold the
bag in place.

Attach Zipper Foot with Guide #14 to the machine,
move the guide three notches to the left, and move the
needle to the far left position. Letting the guide of the
foot ride along welt window edge as shown.

Baste a front lining to the back of the bag front, right
side of lining to the wrong side of bag.

TOP ZIPPER APPLICATION
Attach Zipper Foot with Guide #14 to the machine,
select straight stitch (stitch #1), construction thread in
the bobbin and needle. Open zipper and position the
zipper tape face down along the upper edge of the bag
front, raw edges together, with approximately 2” of tape
at the bottom end of the zipper extending past the edge
of the bag.

Move needle position three “clicks” to the left and slide
the zipper foot guide two notches to the left. Position the
left side of the guide over the zipper teeth and stitch
between the marked dots. Angle the top end of the
zipper into the seam allowance.

Turn the zipper tape to the inside along the stitching
line. Move the needle position to the far left, and the zip-

SUPPLIES

• artista or aurora embroidery system 
or other  combination 

sewing/embroidery system

• 1/3 yard of fashion fabric (silk dupioni)

• 1/8 yard of Armo® Weft interfacing

• 1/3 yard of lining (black lining)

• 7” Tuxedo Chain Zipper by Riri Zippers 

• 12” all-purpose zipper (must have 
plastic nylon teeth)

• 48” of narrow gold chain (available from 
your local home improvement store)

• 2 sets of needle-nosed pliers

• Eight 3/4” gold D-rings

• 11/4 yards of mini piping filler cord 
such as Cordonnet thread

• Construction thread

• Simple floral embroidery designs – 
sample uses designs from Editor Lite 

embroidery software

• Yenmet Metallic embroidery thread 

• OESD Heavyweight Cut-Away 
stabilizer, black

• Large Oval embroidery hoop

• Bottom Line bobbin thread (black)

• HR5 temporary adhesive spray

• Microtex Sharp needles, size 80/12, 
for construction

• Organ Embroidery needles, 
Sharp, size 80/12

• Wonder Tape

• Hand sewing needle

• Reverse Pattern Foot #1/1C

• Zipper Foot with Guide #14

• Pintuck Foot #31

• Favorite fabric marking tool

• Nifty Notions “Cut for the Cure”
7” x 24” ruler

• Rotary cutter and mat

artista Tip

The key to professional-

looking welt openings is to 

keep the sides of the openings 

the same size. Activate the stitch

counter and stitch the along one

marked edge -- your artista will

remember how many stitches 

were sewn, making the 

opposite side the same 

length as the first.
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per foot guide three positions to
the left. Edgestitch along the top,
letting the guide of the zipper foot
ride along the folded edge of the
fabric.

Repeat for the bag back.

PURSE CONSTRUCTION
Staystitch 1/2” from the long edges
of the gusset pieces (lining and
fashion fabric).

Stitch lining front and back to
long edges of gusset, right sides
together, 1/2” seam allowance,
matching top edges and bottom
center markings. Clip gusset to
stitch smoothly around corners.
Press and trim seam allowance
to a scant 1/4”.

Stitch the gusset to the bag back,
matching upper edges and bottom

center markings. Clip gusset to stitch smoothly around corners.
Hint: Stitch seam with Pintuck Foot #31, using piping as a guide.

Repeat for the front of the bag. Hint: Open zipper tape for ease in
stitching.

Press and trim seam allowance to a scant 1/4”.

Insert lining into bag, wrong sides together. Stitch upper edge of
lining to upper edge of bag by hand. The zipper stop end of the
zipper tape will hang freely inside the bag; simply stitch the bag
gusset to the lining gusset, moving the zipper out of the way.

Cut two 4” lengths of ribbon. Slide
a D-ring over the ribbon and serge
the short ends together. Position a
ribbon loop on the gusset on each
side of the bag, stitched edge of the
ribbon 3/4” from the top edge of the
bag. Stitch ribbon to side of bag,
1/4” from edge of ribbon (diagram 1).
Fold loop toward the top of the bag,
covering the serged ends, and
topstitch in place (diagram 2).

Hold the end of the chain with   pli-
ers, use the second set to open
one link. Thread the chain though
each of the D-rings, then use the
pliers to close the link.
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BY NINA MCVEIGH

• 3/4 yard “Luminosity” fabric from
Benartex

• 3/4 yard coordinating fabric for lining 

• 1/2 yard velveteen for cuff and piping

• 1/4 yard gold lamé for cuff piping

• “Quilting Fancy” by Diane
Gaudynski embroidery
collection

• Yenmet gold metallic thread 

• Lightweight bobbin thread

• Silver and Gold Radiance Designer
Threads by QRI and/or Metallic
Ribbon Floss by YLI

• Low loft batting, 12” x 12”

• Free Motion Quilting Foot #29/29C or 

• BERNINA® Stitch Regulator (BSR)

• Clear Embroidery Foot #39

• Bulky Overlock Foot #12/12C

• Clear Appliqué Foot #23

• EZ Glitzer Applicator Wand 

• EZ Glitz Hot Fix Crystals, 3mm
and 5mm 

• 1/4” cotton cable cord for stocking 
piping

• Cordonnet thread for cuff piping

• OESD Medium Weight Tear-Away 

• OESD Aqua Film Topping 

• Fabric marker

• Assorted ribbons, cords and bells
for embellishment as desired

SUPPLIES

Using the pattern from the Pattern Page, draw the outline of the stocking on
Luminosity Fabric, front and back.

Place fabric on top of batting. Using the Clear Embroidery Foot #39, couch
Radiance and/or Ribbon Floss to the stocking front as desired, sewing through

fabric and batting. Freemotion quilt the stocking back using gold metallic
thread. Cut out stocking front and back.

Cut bias strips from the velveteen for piping. Construct piping with Bulky
Overlock Foot #12/12C, using medium weight cording. Baste piping to the
stocking front. Using the same foot, sew stocking back to front. Set aside.

Cut stocking front and back from the lining fabric. Join front to back,
leaving an opening for turning the stocking at a later point in construction;

set aside.

This beautiful Christmas stocking is made of
richly patterned fabric, topped 

with a quilted velvet cuff, and finished 
with glittering crystals. 

Stocking
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Cut a piece of vel-
veteen large enough to

accommodate the cuff
pattern. Mark the center.

Embroider the chosen
design with metallic thread.

The sample shown has a
combination of design

#2 and design #30
from the “Quilting
Fancy” by Diane

Gaudynski embroi-
dery collection. Note:
You may need to
rotate, mirror image

and/or rescale the designs to combine them to fit the
embroidery area.

When embroidery is complete, cut out cuff and
cuff lining. Cut bias strips of gold lame for piping. 

Using Clear Appliqué Foot #23, construct cuff
piping using the gimp cord. Using the same
foot, baste the piping to the cuff, then sew cuff
to lining.

Freemotion quilt the cuff with gold metallic thread. Embellish
cuff with the EZ Glitz crystals.

Finishing
Place the cuff on the right side of the stocking, making sure
top edges are even. Pin  or baste in place.

Position the lining over the
stocking, right sides together
and top edges even. Sew
completely around the top of
the stocking. Note: You may
want to insert a loop of ribbon
or cord into this seam for the stocking hanger.

Turn stocking through opening in lining.

Lift the cuff and topstitch around the top of the stocking,
under the cuff.  

Add ribbons, cords and bells as desired.

PIPING POINTERS

Using the correct presser foot for
piping will make it easy to create
professional-looking piping, no
matter what the size. 

The piping for the stocking uses 1/4”
cording and Bulky Overlock Foot
#12/12C. This foot is perfect for
stitching piping because the tunnel
on the sole of the foot lets the cord
and fabric feed evenly and smoothly
while the needle stitches.

Clear Appliqué Foot #23 works
great for mini piping because of

the narrow 2mm channel on the
sole of the foot. The clear foot
gives you the visibility to see
exactly where you stitch, making it
easy to sew right next to the cord
to create the piping.

PIPED CORNERS AND CURVES
When
stitching
piping
around a
corner,
sew to the
corner, lift
the foot
(with
needle in

the fabric), and clip the seam
allowance up to but not into the
piping. Then, pivot the fabric and
piping, lower the foot, and continue

sewing. The
same technique
is used for
curves, starting
at the beginning
of the curved
area and
clipping every
1/4” - 1/2”.

I S S U E  1 5
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BY MARLIS BENNETT

SUPPLIES:
• 1 yard black wool fabric
• Variegated 30wt Oliver Twist thread
• Design #45 from Quilting Inspirations by Keryn 

Emmerson design collection
• Aqua Mesh stabilizer
• HR5 temporary spray adhesive
• Variegated yarn or wool roving (colors should include 

green and desired colors for petals) for needle punch 
technique

• Wool roving or 4-ply worsted weight oatmeal colored 
yarn for basket

• Thread to match wool fabric 
• Monofilament thread
• Mega Hoop for BERNINA® artista 200E
• Decorative Needle Punch attachment
• Reverse Pattern Foot #1/1C
• Braiding Foot #21/12C
• 12” Pillow form

CUTTING AND PREPARATION
Cut a 16” square of the pillow fabric for the front of the
pillow.

Cut 2 pieces for the back, each 16” x 10”. Use the
selvedge edge for one 10” edge on each piece.

EMBROIDERY
Set up machine for embroidery; thread with variegated
30wt Oliver Twist thread.

Hoop Aqua Mesh stabilizer in Mega Hoop; spray the
hooped stabilizer with temporary spray adhesive.

Center the fabric in the hoop so that the design
embroiders vertically in the center of the fabric.

Embroider the selected
basket design (#45) in the
center of the pillow front,
enlarging it as desired to
fill the space.

After stitching is complete,
unhoop the stabilizer and

remove the stabilizer
from the back of the

fabric. Tip: Use a wet cotton swab to wet the
stitching line on the back of the pillow top, and
then easily pull the stabilizer from the fabric.

The focal point of this striking 
decorator pillow is an outline quilting
embroidery design punched with rich
wool yarn and/or roving between the

lines to add color and texture.

Finished size: 15” x 15”
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NEEDLE PUNCHING
Set up machine with BERNINA®

Decorative Needle Punch attachment
following the directions included with
the attachment. Punch the design
referring to the photo and using the
following directions for each part of
the design.

Petals: Stitch the flower petals by punching the variegated yarn
or roving inside the stitching lines; the blended coloring adds
depth and dimension to the petals. Punch once from the front
and again from the wrong side of the fabric. This creates a
“fuzzy” look to the petals.

Leaves: Using a green yarn or roving, punch the leaves from
the front only.

Basket: Twist the worsted weight yarn or roving so that it
produces a tighter twist and punch into the basket fabric
using the picture as a guide. 

PILLOW CONSTRUCTION
Set the machine for general sewing; thread with construction
thread matching the wool fabric and attach Reverse Pattern
Foot #1/1C

Back: Turn under 1/2” along each
selvege edge of the two back
pieces. Stitch to secure the
hem. Overlap the two back
pieces about 3”. Place
the overlapped back
right side up on
table. 

Place decorated front panel right
side down on the pillow back.

Pin in place and sew around outer edge with a 1/2” seam
allowance. Turn the pillow right side out through opening in
back; press. 

Thread the machine with clear monofilament thread; attach
Braiding Foot #21/12C to machine.

Select a zigzag stitch set at a width to cover decorative yarn
and a 2mm length.

Place yarn under foot and sew 11/2” in from outer edge, creating
a flange; overlap the couched yarn at the beginning and end
and secure. Insert pillow form into back opening.

Overlap hemmed
edges to form

pillow back
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BY BARBARA ALENCI

Quilted 
Scrapbook

Showcase holiday memories by 

stitching a charming cover for 

your scrapbook. Add 

handcrafted pages of your 

Christmas fun and enjoy it 

for years to come. 

Scrapbook Cover Supplies
• Scrapbook (the sample shown has a self-adhesive system

for mounting the front and back covers to the scrap-
book and is available from www.i-makit.com) 

• 1 panel of “Jolly Ol’ St. Nick” by Susan Winget for
Benartex

• 1/2 yard of green fabric for border and back

• 1 fat quarter of burgundy fabric

• 1/2 yard of beige fabric 

• 12” x 12” square of cotton batting

• “Jolly Ol’ St. Nick” by Susan Winget embroidery
collection 

• Patchwork Foot with Guide #57 or Patchwork Foot #37 

• Walking Foot #50 

• HR5 temporary fabric adhesive spray

• Isacord embroidery threads in desired colors

• Assorted decorative threads

• EZ Glitzer with 1 pack of 4mm red pearls and gold
pearls

• Mega Hoop (artista 200E only)

• BERNINA® embroidery software

Scrapbook Cover Instructions
From the beige fabric cut 5 pieces to fit your hoop. Stitch designs and
lettering as indicated below:

Angel: Design #5 
Change size to: height = 91.4 mm and width = 97.8 mm
Rotate design 180°
Stitch, then trim to: height = 41/2" x width = 57/8”

Tree: Design #11 
Change size to: height = 60.2 mm and width = 50.7 mm 
Stitch, then trim to: height = 33/8” x width = 31/8”
Embellish with EZ Glitzer and red pearls 

Reindeer: Design #2 
Change size to: height = 60.2 mm and width = 98.6 mm 
Stitch, then trim to: height = 33/8” x width = 51/4"

Sleigh: Design #3 
Change size to: height = 60.2 mm and width = 72.1 mm
Rotate design 180°
Stitch, then trim to: height = 33/8” x width = 41/4"

Text: 
London font – size: 9.90mm
Digitize: At Christmas Play and Make Good Cheer For Christmas
comes but once a Year
Rotate text 90°
Embroider using burgundy thread
Trim to: height = 25/8” x width = 57/8”
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Carefully cut the Santa with toy bag block from the “Jolly Ol’ St.
Nick” fabric panel, adding a 1/4” seam allowance as you cut.

From burgundy fabric, cut a piece to fit the Mega Hoop (artista
200E only) and stitch the following combined design. Back with
stabilizer and hoop both layers. Note: This design can be
embroidered using other embroidery machines and/or hoops if
you re-hoop and stitch it in sections.

Using the BERNINA® software, combine the following: 
Holly: Design #17

Rotate 90°
Change size to: height = 53.0mm and width = 66.24mm
Duplicate design and mirror image using the Horizontal 
Mirror Image tool
Place designs at opposite ends of the hoop so that the
length measurement is 282.9 mm

Add text to middle of design: 
Swiss Block font – 9.90mm
Type Christmas Memories

Embroider complete design, trim fabric to: height = 21/2" x
width =121/2" 

Sew the Sleigh,
Tree and
Reindeer blocks
together as
shown using
Patchwork Foot
with Guide

#57 and a 1/4" seam.
Press

Add title block to top of
strip.

Sew the Angel block to
the “At Christmas…”
block; add the
pre-printed Santa
block from the fabric
panel. 

Attach to previous strip.

Cut two 21/2" x 111/4" strips of green fabric; stitch to the right and
left sides of the block. Press seams toward border. Cut two 21/2" x
153/4" strips of green fabric; stitch to the top and bottom of block.
Press seams toward border.

Spray the wrong side of the block with HR5 temporary adhesive;
adhere to batting. 

Quilt the seams between blocks using Walking Foot #50, dark
green thread, and a featherstitch. 

Using Walking Foot #50 and a straight stitch, stitch-in-the-ditch
around the borders of the block. Adhere to scrapbook cover
following manufacturer’s instructions.

Quilted Stocking Supplies
• 1 stocking panel of “Jolly Ol’ St. Nick” by Susan

Winget for Benartex 

• 1 yard each of backing and lining fabric

• Two rectangles of cotton batting slightly larger than
the printed stocking

• Isacord embroidery threads in desired colors

• Yenmet metallic thread, gold

• Assorted gold beads  

• EZ Glitzer and 4mm red pearls

• Oliver Twist “Two of a Kind” (Neutral) thread and
cord/yarn collection 

• Decorative cord/yarn/fiber of your choice 

• “Bunka” Designer Threads (Forest) by Quilters’
Resource

• Edgestitching Foot #10/10C 

• Braiding Foot #21/12C 

• Clear Appliqué Foot #23 

• Clear Embrodiery Foot #39 

• Freehand Quilting Foot #29/29C or BERNINA® Stitch
Regulator (if available)

I S S U E  1 5
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Quilted Stocking Embellishment 
Note: Stitch all embellishment techniques through stocking
front and batting. 

Place batting under the stocking front; adhere to wrong
side using HR5 temporary spray adhesive. Trim batting to
match stocking front. 

Attach Clear Embroidery Foot #39 to the machine and use
lightweight bobbin thread with embroidery thread in the
needle. Couch off-white “Two of a Kind” cord/yarn around
the edges of Santa’s beard; couch forest green “Bunka”
Designer Threads to the upper edges of the reindeer har-
ness collars. 

Attach Clear Applique Foot #23 to the machine and select a narrow
(2mm-2.5mm) satin stitch. Embellish details of the pre-printed design

with Isacord embroidery thread and satin stitching. Stitch around
the harness back/belly bands using gold Yenmet metallic

thread in the needle and lightweight bobbin thread.

Attach Braiding Foot #21/12C to the machine.
Couch the reins with your choice of decorative

yarn/cord/fiber. 

Using freemotion stitching and ivory embroidery
thread, thread-paint the chests of the reindeer. Note:

Attach the BERNINA® Stitch Regulator (BSR) to the
machine if available or use Freehand Quilting Foot

#29/29C. 

Outline quilt around the entire design, then fill in background
using your favorite technique (stippling, swirls, loops, etc.).

Still using freemotion stitching and the thread color of your choice,
write Merry Christmas in the upper left corner of the stocking, then
embellish the clouds.

Quilted Stocking Construction Instructions
Cut the stocking from the panel, leaving a 1/4" seam along all edges.  

Place stocking front right sides together with backing fabric; trace
outer edges of reversed stocking onto backing. Cut backing fabric,
making sure that the stocking back is a mirror image of the front.
Adhere batting to wrong side of batting using HR5 temporary spray
adhesive. Trim batting to match stocking back. 

Using freemotion stitching and the thread color of your choice, quilt
the stocking back. 

Using stocking front and back as patterns, cut lining front and back.

Sew the front lining piece to the top of the
stocking front, right sides together, using which
Patchwork Foot #37 and a 1/4” seam allowance.

Repeat for back lining and stocking back.

Place right sides together and sew
around the entire stocking leaving a
5” opening on the side of the lining
for turning.

Turn stocking right side out. Sew the
opening of the lining closed by turning
in the seam allowances and
edgestitching. Push lining into stocking. 

Edgestitch around the top of the stocking with Edgestitch
Foot #10/10C.

Cut a strip of backing fabric 2” by 10”. Fold both long raw edges to
the center of the wrong side of the strip. Fold the strip in half
lengthwise so that the strip is now 1/2" wide; stitch along both long
edges using Edgestitch Foot #10/10C. Fold in half and stitch end of
loop to the back seam of the stocking.

Quilted 
Stocking

This pre-printed stocking 

coordinates with the 

Christmas Memories 

scrapbook. It’s easy to 

sew and simple to 

personalize using 

quilting and 

embellishing 

techniques.
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As a senior in a small high school in Cokeville, Wyoming, I’m involved with basketball, track, cheerleading, extracurricular
academics, art and 4-H (livestock and sewing). I have been in 4-H for nine years and through the 4-H Pact program, I

learned to sew. Having participated in the Make It Yourself With Wool for six years at the
county level, this is the first year I have had the opportunity to participate at the state
and national levels as well.

My sisters and mom have participated in the MIYWW contest for the last 25 years. This is
the first time any of us has placed first in state and went on to nationals. This year I
placed third in the National MIYWW and I also received the 2005 Vogue Award.
Last year I made a formal for my 4-H project and was the State Grand
Champion in the 4-H Fashion and Modeling Revue. After graduating from
high school I plan on attending a university and studying nursing. 

For the MIYWW contest I made a black wool suit using the jacket
(view a) Vogue 7796 and the skirt (view c) Vogue 7937. The fitted
lined jacket has a rhinestone zipper closure. I also made a
detachable simple black wool flower outlined in rhinestones to
the jacket front. The straight skirt is mid-knee with five back
pleats. The fabric I used for this suit is 97% wool and 3% lycra.
The stretch ease lent itself well to the fitted jacket and straight skirt.

I added linings to both the jacket and the skirt, which not only helps
with maintaining their shapes but also cuts down on bulk. After reading
an article in Threads magazine on zippers (they had a rhinestone zipper
pictured and an internet source for purchasing) I ordered a 24” separating
zipper, then started looking for a pattern that would showcase this zipper. I
embroidered a label and added it to the back lining of the jacket. 

The Make It Yourself With Wool Competition, sponsored by the
American Sheep Industry Association, was developed to promote the
beauty and versatility of wool fabrics and yarns, as well as to encourage
personal creativity in sewing, knitting, felting, and other wool garment
construction techniques. Other objectives include the recognition of
creative skills and development of life skills. Entries are accepted in five
divisions: Pre-teens (12 and under), Juniors (13-16), Seniors (17-24), Adults
(25 and over), and Made for Others (any age). Garments must be modeled
by the person for whom they were made, and are judged on the following
criteria: appropriateness to contestant’s lifestyle, coordination of fabric/yarn
with garment style and design, presentation, construction quality, and
creativity. MIYWW contests are held at the state level, with winners advancing
to the National Finals. 

For more information on Make It Yourself With Wool, including state contacts,
visit www.sheepusa.org or send a self-addressed, stamped envelope to: National
Make It Yourself With Wool Competition, Marie Lehfeldt, Box 175, Lavina, MT
59046.

BERNINA® Supports the Make It Yourself With Wool Contest
BY JESSIE BENNION

Jessie won a BERNINA 800DL serger

for placing third in the 2005 National

Make It Yourself With Wool contest
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They're everywhere! Being traded at quilt shows, exchanged
at guild meetings, swapped at lectures, handed out at quilt
classes––any place fabric artists have the opportunity to get
together, deals are going down.

What's the hubbub about? It’s all about fabric artist trading
cards, otherwise known as ATCs. Fast, fun, and frivolous,
these little 21/2" x 31/2" pieces of fabric art bring back memo-
ries of yesteryear, of trading baseball card collections with
friends in front of the five and dime. But different than the
baseball card, fabric ATCs are pieces of your art—mini-
quilts––that you make and trade with someone else.

Fabric artist trading cards are a wonderful way to explore
new techniques without the commitment of a large
project. The nature and size of an ATC encourages both
the experienced and novice artist alike to play and
experiment with embellishment and stitching techniques,
explore new color schemes, even practice freemotion
embroidery.

ATCs constructed of paper collage came on the rubberstamping scene several years ago, but fabric
art groups on the Internet caught the bug and began organizing fabric ATC swaps among members.
A participant of one of the online swaps, fabric artist Janet Ghio, wrote an article about how to make
fabric ATCs in the Spring 2004 issue of Quilting Arts Magazine®. Soon after, the editors of Quilting Arts
Magazine® thought it would be a hoot to host an ATC challenge with readers. The parameters were
simple: readers sent a fabric artist trading card (ATC) to Quilting Arts Magazine® and in exchange one
of the editors made one to send back to a reader. This invited a lot of chaos, stitching, and heaps of
fun. The editors anticipated a little over 300 ATCs, when in reality by the time the challenge closed, the
editors had received more than 800 (823 for those counting). A movement was born.

The Particulars
Although anything goes when it comes to embellishment and technique for fabric ATCs, there are just
a few basic guidelines for making and trading them.

1. Standard ATC size is 21/2" x 31/2".
2. ATCs are backed with cardstock.
3. Your name, date of ATC, and contact information (optional) are placed on the back of the ATC.

A popular way to make fabric ATCs is to make a batch starting with a larger piece of batting or felt
(such as a 9" x 12" piece of felt found at local craft stores). Get started by making a sample batch of
nine ATCs, following the directions on the next page.

BY PATRICIA BOLTON

A R T I S T  T R A D I N G  C A R D S

Note: Cards are 
shown larger than 

actual size.

RESOURCES
Quilting Arts Magazine®

www.quiltingartsll.com
866-698-6989
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DIRECTIONS 
1. Following manufacturer's instructions for the fusible web,
fuse a piece of 9" x 12" fabric to a piece of felt.

2. Now the fun, creative part: embellish the background
with freemotion embroidery, fusing other bits of fabrics to
make am abstract fabric collage, and/or rubber stamp or
stencil designs using paints and inks.

3. Using your rotary cutter, ruler, and mat, cut the
decorated background into nine 21/2" x 31/2" fabric ATCs.
Once cut, you can personalize each card with further
embellishment: appliqué more fabric bits, photo
transfers, quotes that have been transferred to fabric,
beading, stitching, or other embellishment 
techniques.

4. When happy with the individual designs, it's time to
finish the  ATCs by adding decorative edges. You can
simply use a zigzag  or decorative stitch along the
edges, or get fancy by couching novelty threads down
with a zigzag or decorative stitch.

5. Once the edges are complete, they are ready to be backed and signed. Using paper scissors, cut
the cardstock down to nine 2.5" x 3.5" cards. Glue the cards to the backs of the ATCs, and when
the glue is dry, sign and date your ATCs.

Materials
• 9" x 12" piece of felt

• 9" x 12" piece of fabric, 
or a pieced quilt top cut   
to size

• 9" x 12" piece of fusible 
web (such as Pellon 
Wonder Under®)

• 9" x 12" piece of cardstock 
for backing

• Fabric glue

• Pair of paper scissors

• Iron and ironing board

• Sewing machine

• Machine threads of choice 

• Favorite embellishments 
(novelty yarns, hand 
threads, beads, ephemera)

• Rotary cutter, ruler, mat

Tips:
• Keep a stack of 9" x12" pieces of felt fused with fabric handy. If you are about to embark on a larger

freemotion quilting project, warm up by using these smaller felt pieces to practice. Later, when you
want to make some ATCs, you already have some background fabric with freemotion stitching
ready to go.

• Don't throw away your scraps of fabrics that have fusible webbing on them. These tiny scraps are
perfect for fusing to background fabric.

• Build your stash of vintage "treasures" by frequenting yard sales, charity shops, and estate sales. 

• If your tastes run more toward the funky and eclectic, look for inspiration and modern artifacts in
novelty shops, toy stores, hobby shops, dollar stores, and in the sale bins of chain stores.
Children's jewelry, game pieces, drive-thru restaurant toys - look for items that appeal to
your sense of whimsy.

• Pull out your scrapbooking supplies - pretty papers, doilies, hole punches, stickers – and
combine them with your textile treasures.

• Transfer photos and artwork to fabric using one of the many products available from your
local BERNINA® dealer and/or hobby shop.

• Keep a large plastic zippered bag to store bits of leftover trims, ribbons, and laces. Even the
smallest of pieces can have a big impact on such a small "quilt".

• Use your home computer to print personalized card backs. Design it as you would a quilt
label with interesting fonts and fun clipart. Fit eight backs on an 81/2" x 11" page, print
on cardstock, sign your name, and then cut apart to finish your Artist Trading Cards.

• Look for tiny trims and delicate buttons such as the ones used on children’s or doll
clothes. They are the perfect size for the small trading cards.

• Looking for a way to store your growing collection of trading cards? Visit the hobby and
toy shops that sell sports cards such as baseball or football cards. Look for plastic sleeves
and sturdy binders to keep your cards organized and easy to view.

For more ideas 
on making ATCs, 
see pages 21-22.

I S S U E  1 5
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Barbara Alenci
crazypatch, couching, machine 

embroidery,machine beading 

Faith Reynolds
machine embroidery, cutwork, 

Patter Run Outline (BERNINA®

Embroidery Software) 

Jennifer Gigas
machine embroidery, edgestitching, 
sewing on buttons

The Educators of BERNINA®

of America love to stitch and

swap their favorite sewing and

embroidery techniques. These

are just a few of the trading

cards making the rounds at

BERNINA®. Note: The actual
size of the cards shown is 6” x
4”, which is slightly larger than
the traditional trading cards
discussed on pages 24-25.

Belinda Gibson
machine embroidery customizing designs 
(BERNINA® embroidery software)

A R T I S T  T R A D I N G  C A R D S
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Cindy Michaels
stitching on vinyl, 
sewing machine 
lettering, blanket 
stitching

Marlis Bennett
sewing machine lettering, 

single pattern stitching, 
stitching on paper, 
sewing on buttons

Nancy Bednar
serging, machine 
embroidery, piecing

Nina McVeigh
pintucks, decorative 
stitching, sewing on 

buttons, machine 
embroidery

Jill Danklefsen
stitch combination, 
directional stitching, 
freemotion stitching 



BY NANCY BEDNAR

This quilted jacket is fully reversible and has a secret…the quilting pattern comes
from the print of the lining! Simply make a sandwich of a solid fabric, batting, and a
print lining and freemotion stitch the layers together, using the print as a pattern. 

CUTTING AND PREPARATION
Pre-wash both fabrics. Do not pre-wash the
wool batting

Extend the lower sleeve length by 3” at the
bottom edge. This allows enough fabric for
the turn back cuff accent.

Cut one jacket from solid fabric and cut
one jacket from printed fabric. Note: Cut
the jacket pieces 2” larger on all outer

sides to allow for shrinkage when quilting.

Cut same sized pieces of wool batting. Note: Only one of each pattern piece is
needed for the batting pieces.

For test purposes (see below), cut 12” squares each of both jacket fabrics and wool
batting. 

QUILTING TEST
Determine the part of the printed design to
be used for the overall quilting motif. Note:
Trace around the desired motifs using a
fabric marker for good visibility while
quilting, if needed.

Set up the machine for freemotion quilting
as follows:
• YLI silk thread #100 in both needle and

bobbin
• #70 needle
• BSR (BERNINA® Stitch Regulator)

Foot, if available or
• Freehand Quilting Foot #29/29C

With the print side facing up, quilt a portion of the desired design, using the
print as a guide. Turn the fabric over to the solid side. Decide if additional
quilting is necessary for your design preferences. If it is, return to the print
side and continue stitching. Note: Stitches can be added from the solid side
in order to fill in details as needed. 

Once the test square is completed and you have determined your quilting
pattern, proceed to quilting the jacket pieces.

QUILTING THE JACKET
Make a sandwich of fabrics and batting with the right side of the jacket
fabric and lining fabric facing out with a piece of wool batting
between. Pin together or use temporary spray adhesive to bond the
layers. 

SUPPLIES
• Pattern “Nantucket Jacket” by LJ Designs
• Jacket fabric – yardage for 2 jackets – 1 solid

and 1 print
• Hobbs Wool batting
• YLI #100 silk thread
• #70 needles
• Wash away or fade away fabric markers
• HR5 temporary spray adhesive 
• Steam-A-Seam fusible web
• Hand sewing needle and thread
• Presser Feet:

- Edgestitch Foot #10/ #10C
- Bias Binder Attachment (26-30mm) #84 and

Binder Foot #94
- BSR (BERNINA® Stitch Regulator) Foot, if        

available or
- Freehand Quilting

Foot #29/29C

Porcelain Treasures by Benartex was
selected for the lining and binding of
the jacket shown.
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Quilt each jacket unit along desired printed design lines on printed fabric
as determined in your quilting test.

Position the paper pattern pieces of the  jacket on the quilted fabrics and
re-cut the quilted jacket pieces to size as needed.

JACKET ASSEMBLY
Reset the sewing machine for jacket assembly as follows:

• All purpose thread in both the needle and bobbin
• #80 needle 
• Reverse Pattern Foot #1/1C

Stitch the jacket and bind the seams in this order:
1. Shoulder seams    2. Sleeves    3. Side seams

Binding The Seam Allowances
As the quilted jacket is being assembled, the seam allowances are
encased in self-fabric bias binding in order to make the jacket truly
reversible. These binding strips are on the printed side of the jacket,
where they will blend into the overall design and be the least noticeable.
Cut 3” wide, bias strips of the printed fabric. Fold in half along the length
and press, then follow these steps for binding the seams:

A. Stitch these bias
strips into the
seams after the
initial stitching
has taken place.

B. Carefully trim all
seam allowances
to reduce bulk.

C. Press the folded edge of the bias strip over the raw trimmed edges of
the seam allowances.

D. Slipstitch the folded edge of the bias in place on the garment piece,
using tiny hand stitches.

Finishing The Outer Edges 
A double bias bound edge gives a unique accent on the solid side of your
jacket, tying in the fabric used on the reverse side of the garment.

Cut from solid fabric: 3” wide bias strips, piecing together lengths to
equal the entire outer edge of the jacket and lower sleeve edges. With
wrong sides together, fold these bias strips in half lengthwise; press.

Cut from printed fabric: 1” wide bias strips to equal the length of the
solid fabric strips.

Attach the Bias Binder Attachment #84 and Foot 94 to your BERNINA®

sewing machine. Feed the 1” wide printed bias strip into the inlet tube.
Adjust the sewing machine for straight stitching per the guide sheet
included with the binder attachment. 

Bind the edges of the jacket opening and the sleeves in the following manner:

A. Using the Bias Binder
Attachment, sew the printed
fabric binding onto the dou-
bled solid binding strip along
the folded edge. 

B. Stitch the two fabric binding
onto the jacket edge, position-
ing it on the print side.

C. Fold the binding to the solid side, press in place. Using the Edgestitch
Foot #10, stitch the outer edge of the binding in place.

Sew buttonholes in the jacket front and add buttons.

BSR - BERNINA®

STITCH
REGULATOR

The first patented
stitch regulator for a
home sewing
machine, the BSR
makes freemotion
stitching easy for
anyone, even those
who have never
tried it before. The
challenge when
learning to stitch
with the feed dogs

of the machine down is to move the fabric smoothly and
consistently, creating even, regular stitches. Move too fast
and the stitches are long and loose, too slow and they are
tiny and tight. Hours of practice help the stitcher become
familiar with the feel and the pace needed so the result is
stitches that are even and consistent.

The BERNINA® Stitch Regulator operates with a camera-
like sensor that “reads” the fabric through an optical lens
in the foot. The sensor “looks” at the fabric, senses the
movement, and calculates the distance – then directs the
needle to stitch depending on the selected stitch length. For
example, if the stitch length is set at 2.5mm, the sensor
calculates the distance and stitch frequency, repeating
stitches with regular precision regardless of the speed at
which the fabric is moved. 

A standard accessory of the aurora 440QE, the BERNINA®

Stitch Regulator is also an optional foot that will work with
the aurora 430 and the artista 200. 

A choice of two stitching modes makes the BSR useful
for all freemotion techniques such as quilting (outline,
stippling, echo), thread painting, bobbinwork, monogram-
ming, trapunto, shasiko, appliqué, couching, silk-ribbon
embroidery. The stitcher makes the mode selection based on
what is the most comfortable. Mode 1 has constant needle
movement and works well for stitching meandering lines
and tendrils. Mode 2 stops & starts with fabric movement to
allow for accurate design outline stitching. This mode lets
the sewer stop & think about the path the needle is taking.

Three interchangeable soles are included with the
BERNINA® stitch regulator and again, it is the choice of
the sewer that determines which one is used. 
- Closed Metal Sole – Similar to Darning Foot #9, this sole

can be used for a wide variety of projects and most
freemotion techniques. When using this sole, the needle is
centered and visible.

- Open Metal Sole – Similar to Freehand Embroidery Foot
#24, the sole of this foot has an opening in the front to
give an optimum view of the needle. Good for most
techniques and projects, this foot should not be used if the
surface of your project has loose fibers or threads as the
edge of the sole at the opening can get caught.

- Transparent Sole – Glides easily in all directions over all
fabrics, including layers of batting. Marked with cross-
hairs for easy visualization of the needle position, this sole
is especially great for outline and echo quilting.

So, if you tried and been unsuccessful at freemotion
stitching, if you’ve never tried freemotion stitching or even
if you’re an old pro, the BSR is for you.

A

A B C

B C & D
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BY CINDY MICHAELS

Do-it-yourself decorating has become a trend and a source

of excitement and joy for people all around the country. This

creative outlet has become a delightful pastime for people of all

ages as we become artists – our homes are blank canvases,

ready and waiting to take on our unique sense of style. By

choosing our own colors and fabrics, and using the wonderful

tools in our sewing rooms, what might have seemed a daunting

task becomes a fun and exciting adventure. Whether starting

with a simple basic pillow or designing a complete ensemble for

your home, you will find that the family of BERNINA®

sewing/embroidery and overlock machines are truly the home

decorator’s best friends.

Using the pattern provided on the Pattern Page, cut two pieces for each placemat (eight pieces total). The sample features the
basket print border on one side, with the opposite narrower border across the top of the reverse side. 

Make a quilt sandwich – batting between two pieces of fabric, right sides out – using temporary spray adhesive to bond the layers
together. Note: By using heat reflective material on the inside of the placemats, such as Insul-Bright™ batting, they become protec-
tive “hotpads” for your table, an added bonus. 

Quilt the placemat layers using freemotion quilting techniques and Freehand Quilting Foot #29/29C. Or use the
BERNINA® Stitch Regulator (BSR) for the easiest freemotion stitching ever!

Finish the placemat edges with a balanced narrow three-thread stitch with Designer 6 Rayon or Pearl Crown
Rayon in both loopers of the serger. Let the knife of the serger trim the edges slightly (about 1/8”) as you serge.

Dab seam sealant on the edges; let dry, then trim. Add tassel if desired.

Machines and Accessories:

• artista sewing/embroidery machine

• aurora 440E sewing/embroidery
machine with BSR

• BERNINA® embroidery software—  
all levels

• Walking Foot #50

• Freehand Quilting Foot #29/29C

• Clear Foot #34/34C

Notions and Designs:

• Organ Embroidery needles #80/12 for embroidery

• Quilting needles #80/12 for sewing and quilting

• Universal needles #80/12 for serger

• Stencil burning tool

• HR5 temporary spray adhesive

• Insul-Bright™ Lining (The Warm Company)

• OESD Design Collection: Kaye’s Kitchen by Kaye England

R E V E R S I B L E  P L A C E M A T S

S U P P L I E S  
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Threads:

• Metrocor polyester thread for
serger

• YLI Designer 6 or Pearl Crown
Rayon for serger rolled edge

• Isacord polyester embroidery thread
to complement the fabrics

• Mettler Metrosene polyester or Silk-
Finish cotton thread for quilting

Fabrics: 
(4 placemats, 4 napkins, 4 napkin rings)

• “Kaye’s Kitchen” fabric collection from Benartex:

• 21/2 yards Strawberry Basket border print 

• 1 yard each of two coordinating prints: Strawberries and
Embroidered Flowers 

• 1/8 yard of one of the prints

• 1/2 yard of nylon or polyester organza in a    neutral color

• OESD Poly Mesh or Badgemaster water-soluble stabilizer

Cut four 2” wide by 31/2” long strips from one of the coordinating prints. With wrong sides
together, serge seam the long edges, forming a tube, then join the short ends to make a circle.

Hoop a sheet of Poly Mesh or Badgemaster stabilizer in the Large Oval hoop, then attach the
hoop to the embroidery module. 

Select the Strawberry Basket design from the Kaye’s Kitchen
embroidery collection; resize the  to approximately 21/2” x 21/2”
(63mm x 65mm) and duplicate the design. Both should fit into
the hoop nicely. Note: If using the BERNINA® embroidery
software, use the Color Film tool to combine colors so you will
need to change thread colors only half as often.

Remove the hoop from the machine and the stabilizer from the hoop. Use the stencil burner to
cut around the outer edges of the appliqué, taking care not to burn the stitching. Apply them to
the napkin rings with a sewing machine bartack stitch or a little freemotion “scribbling.”

Cut two 18” squares from coordinating prints for each napkin. Place the fabrics wrong sides
together; use temporary spray adhesive to bond the layers.

Roll hem all four sides of the napkin with your serger. This is a great
time to practice different ways to turn corners. For detailed
instructions see the Serger Technique Reference Book or the

Mastering Your BERNINA® Serger Workbook. Be sure to adjust
the upper looper tension to accommodate the decorative thread
you have chosen to use.

Home decorating projects can be so quick and easy that you may decide one morning to have

a theme dinner that night, and serve your meal on a your new table setting only a few hours

later. This easy project of placemats with matching napkins and napkin rings will refresh any summer

meal. Combining beautiful “Kaye’s Kitchen” fabric selections from Benartex with coordinating OESD

embroidery encourages you to have fun and be creative.

R E V E R S I B L E  N A P K I N S

E M B R O I D E R E D  N A P K I N  R I N G S

S U P P L I E S  
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BY MARLIS BENNETT

DIRECTIONS
Note: These directions are for constructing the vest; see
the following pages for directions on embellishment tech-
niques used to create the mosaic fabric.

PIECING THE MOSAIC FABRIC
Machine Set Up: Walking foot #50, construction thread,
size 80/12 Universal needle.

Embellish fabrics as desired (see possibilities on the following page).

Cut all fabric into 5” x 6” blocks. Sew into strips along the 5” width.
Sew strips together side by side to create rectangles of fabric
large enough from which to cut pattern pieces in your desired size. 

Couch yarns or cords over pieced seams as desired. 

Place front and back pattern pieces on the patchwork fabrics and
cut them out as shown in diagram.

Construct garment according to pattern instructions, lining the vest
in the process. 

Use Binder Attachment #84 with Foot #94 to make loops for the
buttons. 

GENERAL SUPPLIES
Note: These supplies are for construct-
ing the vest; specific supplies for
embellishing the fabric blocks are
detailed on the following pages.

• “Mandarin Vest” pattern by
Purrfections

• Fabric assortment in sufficient
quantity to create vest front and
back. Sample garment includes
velvet, linen, silks, home dec, painted
velvet, devoré (burnout) velvet,
ribbons, and tapestry fabrics

• Lining (see pattern for fabric
requirements)

• Construction thread

• #80/12 Universal needles

• Walking Foot #50

• Velva Board by June Tailor

• Nifty Notions “Cut for the Cure” 7”
square ruler

• Rotary cutter and mat

• BERNINA® Ironing System

Lush fabrics along with ribbons,
embroidery and machine 

stitches combine to create a one 
of a kind garment that will 

be a treasure to wear. Embellish 
fabric pieces with a variety 

of techniques, then create yardage
and sew it into an elegant vest.

A garment isn’t finished without a designer label!

• Open BERNINA® Designer Plus embroidery software

• Use Rectangle tool to create a rectangle 110mm
wide by 40mm in height.

• Select the newly created rectangle.

• Right-click on selected item.

• Change Fill to Lacework, pattern L0001a in color 1.

• Use Open Curve tool to create a rectangle within the confines
of the lacework backdrop that is 85mm wide by 33mm in height.

• Use Insert File in File menu to insert design of choice, or use lettering options to
spell initials or name.
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PHOTO SNAP BLOCKS
• Supplies and Set-up: Embroideries were stitched on black linen backed with Poly-Mesh

stabilizer using Isacord embroidery thread through size 90 Organ embroidery needle.

• Software Directions:

- Open BERNINA® Designer Plus embroidery software

- Select Large Oval hoop

- Left-click on Picture tab

- Use Scan Picture tool to scan in desired motif from Traditional Japanese Stencil Designs
by Dover Publishing. If necessary, use Touch Up Picture tool to make any adjustments to
scanned image.

- Left-click on Photo Snap tool. (Settings: Medium Resolution, Light Background, 45° Fill
Angle)

- Left-click OK. Photo Snap process is now complete.

- Save file and transfer to machine for embroidery

- Repeat above process with the same motif (Settings: Medium Resolution, Dark
Background, 45°Fill Angle)

- Save file and transfer to machine for embroidery.

Repeat above process with new motif using the following settings: Medium Resolution, Light
Background, 0 degree Fill Angle.

CANDLEWICK 
BLOCK
• Supplies and Set-up:

Sample was stitched on
green hand-dyed cotton
backed with Poly-Mesh
stabilizer, with Oliver
Twist thread through a
size 90 Organ embroi-
dery needle

• Software Directions:

- Open BERNINA®

Designer Plus
embroidery software

- Select Mega Hoop.

- Zoom out until entire hoop is visible on screen.

- Select Candlewick fill from fill drop-down menu.

- Engage Rectangle tool.

- Left-click and drag a box to fill the straight area of the
Mega Hoop.

- Use Selection tool to select object.

- Right-click to open Object Properties box.

- Select fill style Colonial knot (4mm).

- Left-click on Layout button.

- Use Zoom to zoom in on stitches.

- Move left blue motif towards left.

- Move bottom blue motif towards left, centering between
both upper blue motifs. 

- Press enter key to affect changes.

- Save file and transfer to machine for embroidery.

BLACKWORK 
BLOCK
• Supplies and Set-up:

Sample was stitched on
black linen backed with
Poly-Mesh stabilizer,
with King Tut quilting
thread through a size 90
Organ embroidery
needle.

• Software Directions:
- Open BERNINA®

Designer Plus
embroidery software.

- Select Mega Hoop.
- Zoom out until entire hoop is visible on screen.
- Select Blackwork fill from fill drop-down menu.
- Engage Rectangle tool.
- Left-click and drag a box to fill the straight area of the

Mega Hoop.
- Use Zoom tool to zoom in on stitches.
- Use Selection tool to select stitch object.
- Right-click to open Object Properties box.
- Select fill style B0035a.
- Left-click on Layout button.

- Move blue motif on right towards right, creating some
vertical breathing space between motifs.

- Move top blue motif upwards to create some horizontal
breathing space between motifs.  

- Press enter key on keyboard to affect the changes.

- Save file and transfer to machine for embroidery.

CREATING MOSAIC BLOCKS
EMBROIDERY MACHINE EMBELLISHING
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RIBBON 
BLOCK
Create “fabric” by stitching
ribbons edge to edge.

• Supplies: French ribbons:
1/2 yd. narrow ribbon
and 1 yd. wide  ribbon

• Machine set up: Size 80
sewing machine needle,
Monofilament thread in
needle, construction
thread in bobbin,
Edgestitch Foot #10, Zigzag stitch #2 with 1.5mm stitch length
and stitch width.

• Pre-shrink ribbons using the BERNINA® Ironing System. Adjust
settings so heat level is appropriate for ribbon fabrication and
steam setting is on high. Steam ribbons until shrinkage is
complete. Place one  ribbon on one side of guide, second
ribbon on other side of guide. Sew together with zigzag stitch.
Cut narrow ribbon in half lengthwise. Using the same tech-
nique, sew a narrow ribbon on each side of the wider center
ribbon. Cut strip into 6” lengths using 7” square ruler.

STITCHED
BLOCK
Start with a stripe and
add decorative stitches to
add depth, color, and
interest.

• Supplies: Striped fabric;
Oliver Twist thread

• Machine set up: Thread
size 90/14 Sharp needle
with Oliver Twist thread.
Attach Clear Foot
#34/34C to machine. Select a variety of stitches to embellish
fabric. (Stitches shown: artista 722, 711, 702, 427, 414, and
134.)

QUILTED 
BLOCK
• Supplies: Patterned

home dec fabric; Oliver
Twist thread

• Machine set up: Attach
Quilting Foot #29/29C or
the Bernina Stitch
Regulator (BSR) to
machine, drop feed
dogs. Thread size 90
needle with Oliver Twist
thread of choice. 

• Directions: Using the needle as your paintbrush, paint the
designs on the fabric.

COUCHED 
BLOCKS
Enhance plaid taffeta, designer polyester and striped home dec
fabric with yarns that are “couched” onto the fabric surface.
Couching is a technique that uses specialty feet to attach a
yarn or cord to the surface of fabric. See BERNINA® Feet-ures
for other couching options.

Technique 1

• Supplies: Plaid taffeta;
Isacord thread in
desired color; narrow
cord such as Cordonnet
or Pearl Crown Rayon
thread

• Machine set up: Attach
Clear Embroidery Foot
#39 to machine. Thread
cord through hole in foot
from front to back.
Select stitch #354. Thread size 80/12 needle with Isacord
thread. 

• Directions: Sew rows as desired on fabric. 

• Machine set up: Attach Pintuck Foot to machine Yenmet
thread in Twilight (or desired color). Select blanket stitch. 

• Directions: Place previously sewn satin stitch covered cording
into first groove to right of needle. Sew one row of blanket
stitch on each side of satin stitching. Move satin stitching to
groove on left, mirror image and adjust needle position as
required to get the stitch to lie directly next to satin stitching.

Technique 2

• Supplies: Permanently
pleated polyester organ-
za backed with fusible
Armo-Weft™; YLI
Monofilament thread;
decorative cords and
yarns as desired.

• Thread size 80 needle
with monofilament
thread. Attach
Freemotion Couching
Foot #43 to machine.
Select zigzag stitch #2. Drop feed dog and adjust stitch width
to just cover cords and yarns. 

• Directions: Sew decorative cords and yarns over pleats and
design breaks on fabric as desired.

CREATING MOSAIC BLOCKS
SEWING MACHINE EMBELLISHING
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BY JILL DANKLEFSEN

This beautifully embroidered
pillow features an extra-large
design stitched in four parts but – with a
single hooping of fabric! The secret is the
Hoop-It-All™ Giant Quilters Square Double Wide
hoop frame that helps expand embroidery possibilities to
go beyond the boundaries of traditional embroidery hoops.

First Things First
Before beginning the design
creation process, go to
www.berninausa.com
and download the following
files: HIA-alignmentbox-
V4.ART and HIA Template –
Quilters SquareV.4.ART.*

Go to > What’s New > FREE
Downloads > Hoop-It-All™
templates > Hoop-It-All™
alignment template and 
Hoop-It-All™ Quilters Square
template. Save these tem-
plates on your computer. 

Note: If you have previously
downloaded and saved these
files, you may skip this step.

*Files are also posted for version 
3 of the BERNINA® software.

Preparing The Design 

The finished embroidery design shown on the pillow is simply one design stitched
four times. You send this design to the machine once and use the Hoop-It-All
Quilters Square Double Wide frame, rotating the frame to stitch the repeated
design in each section. Create the “repeat” motif first – it is a combination of two
designs from the Rugs to Riches ETO (Embroidery Take-Out) collection: Design #04
& #06. 

Note: The design shown was created using a aurora machine and Editor Lite soft-
ware. It can also be created and stitched using an artista and any level of the
BERNINA® software.

Creating The Single “Repeat”

Open the Editor Lite software program. Open Design
#04.ART – Turkish flower.

Using the Select Object tool, select the motif, which will
turn magenta. 

Use the Rotate 45° CCW/CW tool to rotate the motif.
Right-click one time.

With the motif selected, right-click to open the Object
Properties box. Under the General tab, change both the
width and height dimensions to 95% of the original size.
Click on OK.

Select File > Insert Design > Design #06.ART > Open.

Use the Mirror Horizontal tool; with the motif selected, right-click to open the
Object Properties box. Under the General tab, input the number –75 in the Rotate
By box. Click on OK.
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SUPPLIES
• Hoop-It-All™ Giant Quilters

Square Double Wide Kit for
the aurora 430 or 440QE 

• OESD Stabil-Stick Tear Away
stabilizer

• OESD Poly-Mesh stabilizer

• ETO (Embroidery Take Out)
Design collection #50004 –
Rugs to Riches by Linda Lee

• Isacord machine embroidery
polyester thread in colors
desired for design

• Organ embroidery needles –
70/10 or 75/11

• Wash away fabric marker 

• 1/2 yard cotton/linen blend
fabric for pillow 

• Fusible interfacing to support
cotton/linen fabric (HTC
Armo® Weft used)

• BERNINA® ironing system

• 20” of cotton fabric for piping
(sample uses Giverny
Classically Home Collection
by Benartex) 

• Soft cotton cording – 1” diam-
eter to make shirred piping –
2 yards

• Construction thread for pillow

• 16” pillow form

• Invisible zipper – at least 3”
wider (longer) than finished
pillow

• Zipper Foot #4 (optional)

• Invisible Zipper Foot #35

• Leather Roller Foot #55

• Embroidery Foot #26

Left-click and “drag” into position as shown to make the com-
bined design.

Select File > Save As and name the newly created design:
Turkish flower and leaf. Close the file.

Open File > HIA Template – Quilters SquareV.4.ART.

Select File > Insert Design > Turkish flower and leaf.ART > Open.

Building The Entire Design

The “repeat” is now finished but you will use the software to “build” the entire
design so you can align each repeat properly to stitch the entire design.

Using the Select Object tool, select the motif, which will turn magenta.

Move the motif into position; copy the motif. Paste
the design three times, arranging as shown by
mirroring and rotating the motifs to create the
final motif.

Note: The BERNINA© embroidery software will
create a design of virtually any size; the design
you’ve just created cannot be sent to the machine.
It must be broken up into smaller pieces that fit
within the boundaries of your machine’s embroi-
dery field. The alignment box file (HIA-alignment-
box-V4.ART ) is a tool to help put the design puz-
zle back together again. It is a 1cm box and will
be a part of the design that is sent to your
machine.

Select File > Insert Design > HIA-alignmentbox-V4.ART > Open.

Move the box into the center corner position as shown. The start of the box is the
upper left corner, which happens to be the center of the hoop. This is easy to mark
and see during the embroidery process.

Select File > Save As and name the newly created design: Turkish flower and leaf
complete.

Hold down the Ctrl key on the keyboard and select the motifs completely within the
right side of the hoop – the alignment box and one repeat of the Turkish flower and
leaf design. 

Copy this selection; select New; Paste.

Select File > Save As and name the newly created design: Turkish flower and leaf
quarter.

This is the final motif that will be sent to your
machine!

Note: If you wish to stitch the motif in different
colors, it is easy to re-color your creation:

- Select the Settings menu > Thread Colors.

- The Thread Chart offers many thread choices -
change colors to your liking > Click on OK

- Save the design with the new colorations.

Select Write to Machine icon; the Device Selection
box opens. Choose your machine model. The
sample was created using an aurora machine.
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When sending a motif to be embroidered to an aurora
machine, EC on PC (Embroidery Control on Personal
Computer) opens. EC on PC indicates to you exactly what to
do to set your machine up for embroidery. There are several
helpful animations that show you when to lower your presser
foot, trim your threads; and even change the thread spool to
the next color in your design.

“HOOPING” THE FABRIC

If you fabric is fairly soft or lighter weight like the fabric used
in the sample (cotton/linen blend) consider adding a fusible
interfacing to the back of the fabric before beginning the
embroidery process. This helps the fabric have more body
and makes it better able to support the embroidery.
Important: Fusible interfacing is not a substitute for proper
use of embroidery stabilizers. You should still use stabilizer
for your embroidery.

Prepare the HIA Quilters Square Double Wide hoop frame
using OESD Stabil-Stick Tear Away stabilizer, peeling the
paper covering away and adhering it to the frame.

Adhere a layer of Poly Mesh cut-away to the Stabil-Stick;
spray the Poly Mesh with temporary spray adhesive.

Place the fabric on the HIA Quilters Square Double Wide
hoop frame, smoothing out any wrinkles. Mark the center
position of the hoop with a “cross” (x and y-axis).

Use the “slide” feature on the Mounting bracket to adjust for
the horizontal axis (x-axis).

Use the Position Motif and
Position Hoop functions in EC
on PC to adjust for the verti-
cal axis (y axis). Using these
two functions in combination
will align the motif properly
within the HIA frame.

Position Motif function - Click
and drag the motif to the desired position so that the start of
it is exactly in the center marking of your fabric.

Position Hoop function - This activates the hoop to show the cen-
ter of the motif, center of the hoop, and the start of the design.

When everything is properly
aligned, begin the embroidery
process as directed by EC on
PC. It shows the color being
embroidered on screen as well
as all of the color number
information.

When the embroidery motif is
completely stitched, a Green
checkmark will show in the
lower right corner of EC on
PC.

After the first design is com-
pleted, remove the hoop and slide the mounting bracket off
the rail. Rotate the hoop frame 90° and slide the bracket
onto the next rail. Attach the hoop and repeat the alignment
process again.

Repeat this process until the entire motif has been stitched.
Remove the fabric from the frame and tear away as much
stabilizer as possible.

PILLOW CONSTRUCTION

Pillow Front

Trim the embroidered fabric to 17" x 17", centering the
design; set aside.

Pillow Back

The back of this pillow has an unobtrusive closure created
with an invisible zipper. Invisible zippers are the easiest of
zippers to insert – if you have the correct tools. Invisible
Zipper Foot #35 has two grooves on the sole so that the coils
of the zipper are held in place as you stitch. And, there is no
need to press open the zipper coils – the grooves on Foot
#35 automatically open them for you. The invisible zipper
should be 3"- 4" wider (longer) than the width of your pillow.
The extra zipper length will be cut off – this makes the appli-
cation easy, as there are no zipper stops to have to deal with.

Cut one piece for the back, 20" x 20". Cut the piece apart
as you wish so the zipper can be inserted at the cut edges,
using the following steps:

Step 1: Select Straight stitch #1 and leave the stitch in the
center needle position. Adjust the stitch length as required by
your fabric.

Step 2: Open the zipper and
position the zipper tape right
side down on the right side of
one piece of the pillow back
as shown. Make sure that the
zipper coil is completely
“seated” in the groove on the
sole of the foot. Stitch the
length of the fabric, sewing
next to the coils.

With EC on PC open, you have the ability to view the largest
screen in the industry for embroidery – your PC monitor!

37

I S S U E  1 5



Step 3: Position the other zipper tape on the remaining backing piece, 
following the same process as above.

Step 4: When completed, zip the back pieces together, leaving the zipper
partially unzipped so the tab will not be cut off when trimming the fabric.

Trim the back of the pillow to match the front (17" x 17"), being careful not
to cut the tab off the zipper. Set aside.

SHIRRED PIPING

A fun way to finish a pillow, shirred piping can also be a creative use of a
fabric print, such as stripes, as shown here.

Step 1: Begin by cutting/tearing the fabric into four 5" strips across the
width of the fabric. 

Step 2: Sew the strips together to create one long strip.

Step 3: Attach Leather Roller Foot, #55 to the machine. Move the needle
position towards the left. Note: You are not “snugging” the cord up tightly
– remember that the fabric needs to be gathered or shirred over the cord.

Step 4: Wrap the fabric strip around the cord, right side showing. Begin
the cording by sewing across the end of the strip, through the cording; this
secures the cording for the shirring process (pulling). 

Step 5: Stitch next to cord. After you have stitched a few inches, drop the
needle into your fabric and slide the cord forward, creating gathers in the
fabric. Continue this process until the entire cord is covered.

Step 6: Distribute the fabric design evenly over the cording.

Step 7: Pin the cording/piping in place on
the right side of the pillow top as shown.
Stitch the piping to the fabric.

Step 8: With the zipper partially open,
place the back right side down on the pil-
low front, encasing the cording/piping and
pin in place as shown. Move the needle
position all the way to the left, getting the
needle as close to the “wheel” of the foot as
possible. Note: Zipper Foot #4 is another
option when making shirred piping; however, the design of Leather Roller
Foot #55 helps you sew very close to the cording/piping.

FINISHING THE PILLOW

Insert the pillow form into the pillow through the zippered opening on the
back and close the zipper.

The following icons represent the
features of the BERNINA©

embroidery software that are used
in creating the design for the

Turkish Flowers Pillow.

Open File

Select Object

Rotate 45° CCW/CW

Horizontal Mirror

Vertical Mirror

Copy 

Paste

New File

Save

Write to Machine

VISUAL 
DIRECTIONS

For complete directions on 
Hoop-It-All techniques,

watch the DVD included
with the product. It contains

45 minutes of
tips and 
techniques
to make
large

designs easy!

COMPANION PROJECT
To make another beautifully embroidered 
pillow using the Hoop-It-All™ Quilter’s 
Square Double Wide frame, go to:
www.berninausa.com

Sewing Studio > Free Projects.
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Stitch Details 
Note: Consult your serger guidebook for the recommended
threading paths for either form of flatlock serging. 

Serger flatlock seams can be sewn using two or three threads:

2-THREAD FLATLOCK
uses one needle (left or
right) and the lower looper
thread only. This flatlock
technique produces the
flattest seaming when
pulled taut.

3-THREAD FLATLOCK
uses a needle thread along
with both the upper and
lower looper. This stitch
makes a strong seam, due
to the needle and two loop-

er threads sewn together. This seam may not pull completely flat
because of the amount of thread in the stitch formation.

Note: Either needle can be used in both stitch formations for a
wide (left needle) or narrow (right needle) seam. 

Tension and Stitch Length
When flatlock stitching, extremely loose needle tension is the
key to a completely flat seam. Depending upon the fabric,
needle tension can be set as low as 1 or 0 to achieve the
desired look. Looper tension will usually be set at a normal
setting of 4-5. 

Flatlock stitch length can vary according to the threads chosen
for your project. Remember that heavy decorative threads need
more room between stitches to nestle smoothly, so the stitch
length will need to be lengthened, probably 3mm or longer.
Conversely, silkier, slimmer rayon threads take on a satiny,
ribbon like appearance if their stitch length is shortened to
1.5mm or shorter. Experiment with fabric scraps from your
project using a variety of threads, adjusting stitch length and
tensions to see what appearances you can give to your fibers.
You’ll be surprised at how a simple change like stitch length
can affect the overall seam appearance.

BY NANCY BEDNAR

Directions for this simple flatlocked shawl can be found in Creative

Serging: Innovative Techniques to Get the Most From Your Serger by

Nancy Bednar and Anne van der Kley.

Part of the fun of owning a serger is 
working with stitches that you cannot find or

duplicate using your traditional sewing
machine. The flatlock stitch is a great example.

Consisting of a needle thread, plus one 
or two looper threads, a flatlock stitch has

both practical and decorative stitch 
applications. Bulk-free, perfectly flat seams

make this serger stitch the seam of 
choice in active wear, sportswear or lingerie

construction. Team this distinctive stitch 
with a variety of weights and types of 

decorative threads, and the unique “loops” 
and “ladders” of the stitch shine with 

endless creative possibilities. 
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Once you have mastered the basics of

flatlocking, your creative journey has just

begun! Experiment with these techniques,

all made possible by the simple flatlock

serger stitch:

DECORATIVE:

Blanket stitching, flatlock couching, fagoting,

fringing, attaching beads and sequins, ladder

weaving

HOME DEC:

Professional drapery hems, soutache pintucks,

custom braids

GARMENT:

Flatlocked and fringed seams, blind hems,

decorative placket zippers

For more serger inspiration and ideas, read:

Serger Technique

Reference Book

Published by BERNINA®

of America, Inc.

Creative Serging:

Innovative Techniques to

Get the Most From Your

Serger

by Nancy Bednar and

Anne van der Kley

Published by Sterling Publishing, Inc.

Stitch Steps
Flatlock serging is a two-step process. Fabrics can be placed right
sides together or wrong sides together, depending upon which side
of the stitch you want to showcase (the “loops” or the “ladders”).
Unlike other serger stitches, the flatlock can be serged on the
edge of two pieces of fabric as a seam or along a folded edge
anywhere on the surface of the fabric.

STEP 1:
Place fabrics right or wrong sides together. Serge along the edges.
When you look at the seam, the stitches will look much looser and
a little different than those in a traditional overlock seam – this is
correct. The needle thread and the looper thread(s) should meet
on the edge of the fabric but will not be tight against it.

STEP 2:
Separate the fabric layers and gently pull the unserged edges of

the fabrics apart, to the
left and right. Magically a
new stitch will appear!
The loosened needle
tension allows the seam
to pull flat. 

This seam has two
distinctly different sides:
One side of the seam
looks like a row of looped
zigzag stitches.

The second side of the
seam looks like small
horizontal stitches,
seemingly floating over
the fabric with no visible
support. This side is
called the “ladder” side
of the flatlocking and
offers great creative
possibilities.

Flatlock 
Fun!
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BY MARLIS BENNETT
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This elegant table
covering features a
rich ribbon border,
beautiful holiday

embroidery designs
with organza 
inserts and 

free-hanging 
tassels. The gold
metallic thread 
adds a touch of
sparkle for that 
holiday look.

PREPARATION AND CUTTING

Preshrink linen - it should be laundered, dried, lightly starched and pressed.
Cut linen 48” square. 

Steam-press ribbon with iron set on appropriate heat setting for ribbon content
and high steam. Note: Test 2” piece of ribbon for colorfastness in lukewarm
water.

CONSTRUCTING THE TABLECLOTH

Turn up 21/2“ hem to the right side, mitering corners. Sew mitered corners,
leaving the raw edges of the hem unstitched. 

Position ribbon on right side of fabric over raw edge of hem, 2” away from
folded edge, mitering corners; pin in place. 

Attach Edgestitch Foot #10/10C to machine. Insert bobbin filled with Bottom
Line thread in desired color. Thread #70 needle with 60wt cotton thread to
match ribbon. Edgestitch ribbon in place along  both edges.

EMBROIDERY 

Corner Design
Hoop Aqua Mesh Plus in large oval
hoop. Remove protective paper from
stabilizer. 

Position corner of tablecloth into hoop.
Add a 3” square of heavy weight cut-
away stabilizer under corner so that 1/8”
is under the corner. This will add addi-
tional support to the tassel embroidery
and will not remain in the finished proj-
ect. Note: For clarity, the photo shows
the corner with the stitching complete
and the tassel clipped and released.
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SUPPLIES

• 50” square of medium-weight 
linen

• 1/4 yd sheer organza in desired 
color

• 42/3 yds 13/4” wide embroidered 
ribbon

• Tassels & Trims by Louisa Meyer 
Special Collection CD #’s 25, 
27, 29, 30 and 31

• Yenmet Metallic thread - gold

• Isacord embroidery thread in 
desired colors

• Bottom Line thread by Superior 
threads in color to match linen

• 60wt cotton sewing thread to 
match ribbon

• Aqua Mesh

• Aqua Mesh Plus

• Heavy weight Cut-away 
stabilizer

• HR5 Temporary Adhesive Spray

• Edgestitch Foot #10/10C

• Embroidery Foot #15

• Clear Foot #34/34C

• Large oval embroidery hoop

• Size 70 sewing needle

• Size 100 wing needle

• Size 80 Organ embroidery 
needle

Recommended:

• BERNINA® embroidery software

• Nifty Notions curved tip 
embroidery scissors

• Nifty Notions Cut for the Cure 
7” x 24” ruler

• Sew Steady table for 
embroidery

• BERNINA® Ironing System

• Mega Hoop

Position embroidery motif #30 on corner so that tassel portion hangs off corner
with the center of the design 5.1cm in from the corner. Embroider using
Yenmet Metallic thread. 

Repeat for remaining 3 corners. 

Mark and Measuring
Mark the center of the tablecloth by drawing a horizontal and a vertical
guideline that intersect in  the center. Draw diagonal lines that also intersect in
the center (see diagram).

Center Design
Hoop Aqua Mesh stabilizer in large hoop. Spray stabilizer with HR5 temporary
spray adhesive. Place  center of table topper into hoop, pressing firmly to
adhere. 

Combine four of design #25 on the embroidery machine screen to form the
central motif. Tip: Engage on-screen gridlines for ease in positioning. 
Embroider the center motif (see the following page) in desired colors using the
Organdy Appliqué process.

Side Designs
Measure and mark 16” from center of cloth to center of design along the
drawn horizontal and vertical guidelines. Embroider motif #31 at these marks.

Measure and mark 93/4” from center of cloth to center of design midway
between the drawn guidelines (45° angle from center). Embroider motif #27 at
these marks. (See diagram on following page.)

*Note: machine was stopped during color #11 to allow for a user desired color
change. Stitch highlights in leaves, stop machine, change thread to desired
color and stitch outline of ornament.
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Wing Needle Stitching
Draw a square with fabric marker 1” from inside of ribbon. 

Insert wing needle. Thread machine with Bottom Line Thread; attach Clear
Foot #34. 

Sew stitch #720 on drawn line, with the “pins” of the stitch facing towards out-
side of tablecloth. 

Sew second row 1/4” away, towards center of tablecloth with the “pins” of the
stitch facing towards center of tablecloth. Do not stretch or pull while sewing
on the diagonal. 

Completing The Embroidery
Embroider the connecting dots motif #29 between the outer embroidery
motifs (see diagram as a guide).

Remove stabilizer by rinsing in tepid water. Cut corner stitching to release the
tassels, releasing the stabilizer in the process. Hang to dry.

ORGANDY APPLIQUÉ
• Start the design and sew the

straight stitch only; stop
machine after this stitch if
necessary.

• Cut tablecloth away inside
stitching. Do not remove
stabilizer.

• Place sheer organza on
top of design, covering the
openings. Begin stitching
again, sewing until zigzag
stitching is complete.

• Stop machine. Trim organza
close to edge of zigzag stitch
taking care not to clip into
stitches.

• Complete embroidery
process stitching design in
desired colors.

The complete arrangement of designs
includes designs #25, #27, #29 and
#31 from the Special Collection
included with the Tassels and Trims
book. Note: Tablecloth was designed
in BERNINA® embroidery software,
embroidery templates printed, taped
together and measurements taken
from templates.



FREE
Instructions

FREE
Screensaver

FREE
Bookmarks

Relive the creativity of the 
Sewing Symphony program! 

Download this colorful 
screensaver showing the sewn 

samples and stitching 
details of the projects featured 

in the Sewing 
Symphony program. 

www.berninausa.com/
symphony

This beautiful series 
of vibrant bookmarks features 

several of the garments 
showcased in the BERNINA®

Fashion Show. Download 
your own set, add tassels, 

and mark your place!

www.berninausa.com/
symphony

Join the latest craze and 
create Artist Trading Cards. 

To duplicate the 
BERNINA® ATCs shown 
on pages 26-27, download 

directions and get 
started today!

www.berninausa.com/
symphony

We hope you enjoy this issue of 
Through the Needle and our Sewing 
Symphony program. As a token of our 
appreciation of your support, BERNINA® has 
a few gifts for you. To receive your free gifts, simply
log on to the BERNINA® website using the special
address listed on the coupons. Enjoy!
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